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What is Splash!

Introduction

Splash! is a fully accessible maths and graphics application.  It provides users with 
workspaces, and a way for teachers to create worksheets for subjects like Mathematics, 
Science and Design. It was originally based on the award winning ACE Centre program 
‘AccessMaths’ and its companion ‘Number Navigator’, improving and combining them into 
one package, and greatly extending their functionality.

Who can use Splash!

The interface configuration capabilities mean that resources, activities and worksheets, 
can be created for a large range of educational stages and curriculum areas from early 
years, to secondary education, 16 years or older. 

Splash! gives Access to drawing, working with shape, and number activities

Accessibility

Splash! is accessible to users with a large range of physical difficulties and is designed to 
be fully controllable with a range of input devices.  All functionality can be accessed from a
keyboard or equivalent with no pointer use;  or with a pointer device and no keyboard – 
using an existing on-screen keyboard for normal typing.

User and Teacher Modes

When using Splash! screen and tools can be viewed in one of two ways.  The 
user will have tools specific to their requirements of the current activity.

The teacher has more power and teacher mode can be turned on from the 
Options Menu on the toolbar or a keyboard command (Control + T).  This will 
give access to many more tools, palettes      and configuration possibilities.
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Opening screen / User’s menu
When the software first starts it will open in the user’s menu screen, for example:

Splash can store profiles for multiple users.  Press the “Change user” button at the top 
right to switch users or create new ones.  When the software is first installed it will usually
create two or more default users for different KS levels.

Activities

The large buttons on the page are the main functional activities of Splash.  An "Activity" is 
a resource which has selected tools and capabilities customised to the users’ needs and 
the educational stage.  When any of these buttons is selected the main work screen is 
displayed with a blank page, but different tools and options suited to that activity.

The buttons included here are initially determined by the KS level selected when the 
profile was created, but individual options can be added or removed later.

Worksheets

The last button is a folder of sample
worksheets.  These contain content within the
work area as well as a selection of tools, similar
to a printed worksheet, for example:

Typically the worksheet would contain the tools from one of the standard activities; 
however it is possible to customise these fully for individual worksheets,  for example to 
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hide irrelevant features, so that the user only sees the tools options and palettes that are 
relevant

Again it is possible to remove these and/or add your own worksheets and folders or sub-
folders to the menu.

You can alternatively open an existing Splash file from disc, which isn’t on the user’s 
menu, using the File menu.
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Using the Splash! Drawing Screen

The parts of the screen

The Splash! workspace is framed by controls - the picture above shows the default, with 
almost all options visible.

The main parts of the screen are:

All of these can be customised or hidden to suit the user or current work.  This is 
explained below (see p18), but first we will briefly describe the different areas:
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Toolbar and Menus

The toolbar has 4 main groups of items:

1 – The first 2 buttons switch between User and Teacher modes.  Teacher mode has some
extra editing and configuration options.  It is also possible to create worksheets which are 
protected so that the user can only modify parts of the document – the rest is edited in 
Teacher mode.  Control+U and Control+T can also be used to swap between these.

2 – The next 3 buttons select if the pointer position is snapped, and how (see p10).  The 
key combinations Control + F6 to F8 select these and Control+F5 selects no snapping.

3 – For keyboard users a button represents the step size when the pointer is moved by 
the keyboard arrow keys.

4 – And the remaining buttons are general functions such as Save, Open file, Undo etc.  
All these have key equivalents – these can be see in the equivalent options in the menu.

The buttons in the functions area can be individually added and removed.  The other 
sections can be hidden as a group.  See p18.

Menus

The menus above the toolbar are fully accessible with a keyboard, use Alt + mnemonic 
key (the key underlined when Alt is pressed, for example Alt + ‘F’ for the file menu).  You 
then use the mnemonic menu item keys or arrow keys to highlight the item you want to 
use and press Enter to activate. The menus also have reminders of the direct keyboard 
short-cuts like Control + P for Print. 

If the user finds the menu easier to access than using key combinations to select tools, an
extra menu can be added which includes all the items in the tools palette on the left.  This
is changed in Settings > Screen Contents and Layout > Screen Contents.

Tools area

On the left of the screen are all the tools which can be used to draw, write or create 
content.  These are explained individually later in these instructions.  The items listed here
depend on the activity selected when opening the work screen.

Each has a key combination that can be used to select it, which is displayed on the button.

The large button above the tools allows the user to change between the activities (they 
might, for example want to swap back and forth between graph drawing and equations on
the same page), or to return to their menu.  F12 is the equivalent of clicking on this 
button and opens a menu which keyboard users can navigate using the arrow keys and 
Enter.

Palettes – options and styles

On the far right (initially) are the various palettes which offer styling (such as colours, font
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size etc) and other options for the selected tool – for example when working with 
equations these show the various things that can be added such as square roots, divisors 
and so on.

Some of these palettes will show a key combination which can be used to select the 
palette as long as keyboard-only was selected in the accessibility settings – this is 
generally the case for the styling ones.  Some others wouldn’t typically be used by 
keyboard users as they offer pointer users access to things which would otherwise be 
typed (this is the case for most with extra content for individual tools)

All of these palettes can be undocked and moved around the screen by dragging the title, 
or selecting it and these using the key combinations Shift+Alt+M to move or Shift+Alt+R 
to resize followed by the arrow keys and Enter to finish.

Page thumbnails

To the left of the palettes are thumbnails showing the pages in the document and the 
current page.  Keyboard users can navigate between pages with Control+Page Up/Down.  
Other page related keys are shown on the Page menu at the top.

Keyboard Control Introduction

Splash! can be fully accessed by users who have no control of a mouse pointer or other 
devices like tracker balls, head pointers or eye gaze.

Note: the pointer remains active even if the user is only using the keyboard.  This means 
an assistant can still use the mouse within the software.

The main keys used by Splash! are:

• the arrow keys move the pointer around the screen

• The F2, F3, F4 keys switch between small, medium and large steps (by default for 
users with keyboard-only access a button on the toolbar shows the current 
selection and can change it.  This button can be hidden in the user settings 
however).  The default is for (approximately) 1, 4, and 25 mm steps respectively 
per key press but this can also be changed in the user options.

• 'Space bar' or 'Insert' are equivalent to a left click

• 'Return' or 'Enter' is the same as left double click 

• 'Escape' cancels or undoes the last step when drawing out a shape (which pointer 
users do with a right-click)

Using Key combinations

For those users that have problems holding down one key when pressing another, rather 
than including the accessibility within Splash! we recommend that the 'Sticky keys' 
facility in the system settings are used.

Snap to...

To assist positioning, Splash has a versatile mechanism for
snapping the position where a user clicks, so that the user does not
need to be so precise.  There are three basic 'Snap to' modes in
Splash!.  The user can change between them at any time by pressing the key combination
shown below.  
Each time a point is fixed on the screen when creating shapes and using tools the current 
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point will move automatically to a nearby point depending on the mode:
 The nearest page grid intersection - Control + F6
 An existing nearby shape - Control + F7.  
 Fix the angle of any line being draw to the nearest 15 degrees. - Control + F8.  

When moving existing shapes this restricts movements to either horizontal or 
vertical.

To switch 'Snap to' off, press Control + F5.

Keyboard users can optionally enable an additional 'snap to’ a set
of shortcuts to the nearest important points (see picture right,
and details below).  

Snap to Grid 

Every page of Splash! worksheet can have a grid assigned
to it (see p21). This grid may be invisible.  

The grid configuration - size and style are set in the menu: Page > Edit grid and 
background.  If snap to grid is enabled then each time a shape or tool is created or edited,
the point will always jump to the nearest grid intersection. 

Snap to Shape

Snap to existing shapes: When this is selected the software will automatically 
select part of an existing item on the page if the user clicks nearby.  This 
includes lines, corners, and where lines cross.  A purple highlight shows when 

the pointer is close enough to a shape that the software will lock on to it.  When
moving shapes it will try to snap them together so that they tessellate.

Angle

'Snap to angle' does not affect all shapes and tools.

Lines, including the sides of shapes not fixed by the geometry of the drawing 
being drawn are restricted to steps of 15 degrees – 15, 30, 45, 60, 90.  When 

moving existing shapes this restricts movements to either horizontal or vertical.  The initial
point of a shape is not snapped with this option.

Snap to Near Points for Keyboard Users

These can optionally be switched on for keyboard users in Settings > 
Accessibility > Keyboard settings > Display automatic mouse jump 

shortcuts in document. 
These appear as key shortcuts within the document, using the keys F5 - F8, which jump 
the pointer directly to likely nearby locations. 

Editing shapes

This section covers the general editing of shapes.  Look into the 'Transformations' section 
for mathematical changes regarding translation, rotation, mirroring and enlargement. 

Adding shapes to the page

There are instructions for each tool starting on page 42.  However, the principle is the 
same for most:

• Select the tool, by pressing its key combination (shown in green on the button); or 
by clicking on the tool in the palette on the left.
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• Move the pointer to the position on the page where you want to start drawing and 
press Space.  For text shapes this positions the cursor and then you can start 
typing.

• Move the pointer to the next position of the shape and press Space again.  The 
exact result depends on the shape: for most simple polygons these 2 points form 
the first line of the polygon.  For a circle the first point is the centre, and the 
second a point on the edge setting the size.  See page 42 for details

• If the shape has an unlimited number of points (eg the 'Irregular polygon' or curve 
tools), then press 'Enter' instead of Space to place the last vertex and complete the 
shape.

• At any time press Escape to remove the last point that was placed.  You can press 
Escape repeatedly to remove several vertices in shapes that have many lines.

At the bottom of the screen, in the info panel, the software displays the main actions 
available at the current moment for the shape being drawn.

Selecting existing shapes

Select 

To select a shape or other object - press F9 to select the pointer tool.
Move inside the object and press Space.  The object will be selected, it
will be outlined and the editing 'handles will appear' 
If two or more objects are on top of each other then pressing Space
again will select the next one underneath.

Selecting multiple objects

Splash! is able to make certain changes such as Colour Fills and Line style to more than 
one object at the same time.  In order to do this multiple objects have to be selected. This
can be done with the Bounding Box selector ‘B’, or “Shift selecting” the others: 

• With the select tool move to the first object and press Space.

• Move to the next object, press Shift + Space.

• Repeat this until all the objects you want are highlighted.

• To un-select an object Shift + Space it again.

Note: This selection method will not select objects which are underneath other objects, 
you have to select by pointing to unique points within the objects to be selected.

Other keys

• Control + F9 will select the next shape in order 

• Shift + Control + F9 will select the previous one. 

• Control + A selects all objects on the page
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Moving or Editing a shape

Moving

Objects can be moved by using the F9 tool.

Move into the object to be changed and press Space.

The Handles (editing points) for the shape will appear, depending on the shape(s) 
selected. The central handle moves a shape around the page.  The one to the right of that
rotates it.  Many shapes will display handles at the corners allowing it to be stretched.  

Move the pointer over the central handle and when it flashes and press Space again.  
Move the shape with the arrow keys and when you want to fix the change press Space.  If
you made an error then pressing Escape will restore the object back to its starting 
position.

The key combinations Shift + Arrow key, can also be used as a shortcut to immediately 
move the selected shape(s) a small amount without needing to select the central grab 
handle.

Adjustment handles on a shape

The central handle moves the shape

Rotating

To rotate an object point to the handle with
a short arc going through it, when it
flashes – press Space then use the arrow
keys to move.

Re-sizing/shaping

To re-size choose the handles on the corners or sides of the
shape to be re-sized then use arrow keys. The amount of
reshaping that can be done depends on the object. 

Moving the handles on the edges of the selected object(s) will change the proportions of 
the object(s).  For lines the vertices, ends and critical points can be moved individually.

Deleting a shape

Just select the shape and then press either Backspace or Delete to remove it.

Normal editing functions

Standard editing functions, such as copying and pasting are available from the Edit menu. 
Likewise you can undo (or redo) recent changes.  These work just like in most other 
software.  There are key shortcuts for of these functions (these are the standard key 
combinations used in most software):

• Control + C = Copy

• Control + X = Cut

• Control + V = Paste

• Control + Z = Undo last change

• Control + Y = Redo last change which was undone

You can, in theory, a copy and paste from Splash into other software.  However, due to 
the complex, but it is often interactive, nature of Splash shapes this is rarely successful.  If
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you want to add an image of a Splash page into a document, it is usually best to either 
export the entire page as an image (using the File menu), or use the Window snipping 
tool to grab an image from the screen.

Secondary pointer

Most keyboard users are moving the normal Windows cursor around the
screen using the keyboard arrow keys (or equivalent).  Splash can
optionally, however, use 2 separate cursors: a separate one for the
keyboard user, with the standard Windows pointer one being controlled
by the mouse as normal.  This mode may be useful when an assistant
needs to help the student with some work – the assistant can use the
standard cursor to perform some actions such as changing colours or tools, while the 
student uses the keyboard pointer within the drawing area.

This option is switched on in Settings > Accessibility > Keyboard settings > "Use separate 
keyboard drawing cursor".  Once enabled both cursors move completely separately, and 
either can be used for any function . The space and Enter keys will draw at the location of 
the keyboard cursor;  clicking the mouse draws at its location.  Once you start a shape 
with one, it must be completed with the same mode.  For example if you press Space to 
start a shape, clicking the mouse would no longer complete it (but could still be used to 
change the selected colour)

Changing Key assignments

Every key assignment or short-cut can be changed.  This can be done either in the user 
settings, to change keys to ones a user finds more convenient.  The teacher counts as a 
different user profile if changing keys in the user settings. Alternatively specific key 
combinations can be assigned within individual worksheets or activities - usually to assign 
keys to any custom tools that they use.

A copy of the default keyboard short-cuts is given in Appendix 1. 

You can change the assignment of keys in the settings screen. (Select from the menu: 
Options > Edit settings > Edit settings for (user name) and then select the Keys page on 
the left.
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To set a key:

• Click in the box top-left and press the key combination.  It can be any key plus any 
combination of the Shift, Control and Alt keys.  Below the box the software will tell 
you what, if anything, the combination currently does.

• Then select the action from the list on the right.  The actions can be drawing tools, 
almost anything from the menus, and most options on the palettes on the right.  
The actions are organised into folders - but you can also search for an action by 
typing part of the name in the search box.  The selection will move through the list 
as you search.  Press 'enter' in the search box to jump between different entries 
matching the search (eg if you enter “Polygon”, pressing enter will jump between 
Regular Polygon and IrregularPolygon)

• The software tells you the keys, if any, that already perform the action - you may 
be able to use this rather than assign a new key.

• If you want to make the change press the long '= Assign =' button. 
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Changing the display
Different activities and worksheets will display different options and tools.  There are 
various things that you can change to make it easier to work with a particular document.

Zoom

You can zoom in or out on any document.  If you zoom in scrollbars will be displayed; if 
you zoom out so that the entire document is visible these will not be shown.  You can 
scroll with the keyboard by pressing Control plus the arrow keys.  Some users may find it 
difficult to use a view which needs scrolling.  You can zoom using keyboard shortcuts (or 
the toolbar buttons or entries in the 'Options' menu):

• Control + = zooms in

• Control + - zooms out

• Control + 1 resets to 100% size.

• Control + 2 zooms so that the entire document is visible without scrolling

• Control + 3 zooms so that the width of the document fits the screen.  It will not be 
necessary to scroll horizontally, but may be necessary to scroll vertically.

Rotation

It is possible to rotate the document on screen – as a student might rotate a piece of 
paper on their desk.  The following keys can be used:

• Shift + Alt + Left arrow: rotate left.

• Shift + Alt + Right arrow: rotate right.

• Shift + Alt + "=": reset display to the normal way up.

Rotation is done in 1/16ths of a complete rotation.  Ie rotating 4 times rotates through 90 
degrees.

Full screen view

Pressing shift + control + F11 at any time enters or leaves "full screen view".  This view 
removes the toolbar at the top of the screen, the page thumbnails for multiple pages, and 
the information areas at the bottom.  The tools on the left, and the styling palettes 
(usually on the right, but moveable) are still displayed.

Palettes

Note: This section describes using the mouse to move
palettes - often this will be done by a teaching assistant.  The
key equivalents that allow a keyboard-only user to do the
same are also listed.

By default the palettes containing the styling for shapes and
various other options are displayed on the right-hand side.
Exactly which ones are displayed depends on the worksheet
or activity, and the user settings - you can quickly change
which are displayed by pressing F10 (see p18)

If there are many palettes some will collapse to show just
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their title, as in this picture.  Just click the title to expand the palette to use it.

It is also possible to move the palettes anywhere on the screen.  Just click and drag on 
the title of a palette to move it.  They can be dragged away from the area on the right so 
that they float freely above the page (it may be useful for a user with limited control to 
place a palette they are using frequently very close to where they are working)

From the keyboard to move a palette, press the key combination to select it, and then 
press Shift + Alt + M.  Then use the arrow keys to move it and either 'Enter' to confirm or 
Escape to cancel.

If you drag a palette to the area on the right it will dock with the others.  Where you drop 
the palette vertically determines the sequence in which they appear - so you can move the
dock palettes up and down the list by dragging them.  An indicator will show where it will 
dock: (the white bar labelled “Insert here”)

You can create extra columns of palettes by dropping a palette at the edge of the existing 
column like this:

You can do this on the left-hand side of the screen as well as the right.  So it is possible to
sswitch the palettes to the left-hand side, by dragging each one over to that side.
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Resizing palettes

You can make the entire column of palettes docked at the edge of the screen smaller or 
larger by clicking and dragging on the very left-hand edge of them (the pointer changes 
when you are in the right place to do this)

If a palette is undocked and floating, you can resize it by clicking and dragging in the 
bottom right-hand corner of the palette.

Alternatively, if you right-click on the title of a palette a menu is displayed.  The “Make 
smaller” and “Make larger” options will change the size by about 25%.

From the keyboard to resize a floating palette, press the key combination to select it, and 
then press 'Shift + Alt + R'.  Then use the arrow keys to resize it and either 'Enter' to 
confirm or 'Escape' to cancel.  You cannot resize an entire column of docked palettes 
simultaneously from the keyboard.

Resetting palettes

If palettes have been moved you can reset them all to their default locations (usually 
docked on the right) by selecting from the menu: Options > Reset positions of palettes.  
This does not change which palettes are displayed, only where.

Adding or removing screen elements

Hint: the view is configured separately for User and Teacher modes.  Generally teacher 
mode displays almost the entire Splash interface.  If you are a teacher or assistant 
wanting to temporarily use some feature which is not currently displayed, the easiest way 
is to switch to teacher mode.

Most of the parts of the full Splash work screen can be hidden or displayed in the settings.
Hiding unnecessary elements can make more space for the document on a smaller screen.
Most worksheets, especially for younger users, start with a minimal interface.  Most 
activities show all the general elements (such as the information line at the bottom), but 
will only include tools and palettes relevant to the activity.

Version 3 contains a new function to more easily change what is shown on the screen.  In 
the main work area, press F10 to display the screen content editor:
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To add something which is not currently displayed, use the "Add item to screen" link.  This
will show a menu of screen areas and tools.

To modify or remove something, click on it first.  While this content editor is open none of 
the rest of the Splash screen will affect your document – instead the content editor will 
highlight it and show options to modify whatever you click:

As in the screenshot above, this may show options both for the general part of the screen 
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(the tools area in this case), and for the specific button.  So in this case it's possible to 
hide the tool button selected, or to hide/modify the entire tools area.  The exact options 
available depend on what was selected.

To close the content editor press F10 again, or click the "Finish" button.

Scope of changes

Splash will automatically decide for any changes how widely they should be applied.  In 
general adding/removing tools or palettes will only affect the current activity for the user. 
So a change in the equations activity won't affect the geometric drawing, for example.  
Most other changes, including adding or removing buttons from the functions toolbar at 
the top (which has Open, Save, Undo etc by default) would apply for the user throughout 
the software.

You can force changes to be applied differently by changing the "Apply changes to:" 
option at the top.  You can choose to have changes apply only while the current document
is open – which may be helpful for adding unusual tools needed for a particular exercise, 
but which the student wouldn't often want.

Shortcuts

There are shortcuts that can help show or hide some screen items more directly:

• The prompts panel at the bottom which shows actions that can be performed can 
be hidden by clicking the close button in the top right corner.  It can also be 
hidden, or displayed again by pressing 'Shift + F1'

• You can change the tools visible on the left by switching to teacher mode and right-
clicking anywhere on this panel.  This displays a menu which can add or remove 
tools.

• Any palette can be hidden by right-clicking on it's title and selecting Hide from the 
pop-up menu.  
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Multiple pages and modifying the page

Multiple pages

Although many documents are 1 page, they can contain any
number of pages.  Thumbnails of the pages are shown
between the main display and the style palette on the right.

Note: for many worksheets and for KS1 users this is usually
hidden.

The following keys can be used:

• Control + Page up moves to the previous page, if any.

• Control + Page down moves to the next page.  If you
already on the last page, it creates a new, blank page.
However, it will only do this if the last page is not
currently blank: further pages will not be added until
some content is added to the last page.

The Page menu has further options for changing the list of
pages, such as deleting a page or changing their sequence; or
use the following key combinations:

• Shift + Control + Delete: Delete the current page.

• Shift + Control + Backspace: Clear the current page without removing it

• Control + Alt + Page Up/Down: Move the current page up and down the list-size

• Shift + Alt + Insert: Insert a copy of the current page

• Shift + Control + Insert: Insert a blank page after the current one (if you are on 
the last page Control + Page down would do this – but this combination can also 
insert pages in the middle of the document)

• Shift + Control + Alt + Insert: Insert a blank page before the current one

Changing the page

Both the size of the page and the background can be changed:

Use the menu: Page > Change page size... to change the size of the page.  

Use the menu: Page >Edit grid and background... (or key combination Shift + Control + 
Alt + P) to change the background grid, colour or image.  Splash! Has a wide spectrum of 
paper styles which can be applied to any page in a document.  The paper can set to a 
number of styles from plain to graph and the drawn graticule. 

From the keyboard, the arrow keys will step through the initial options, and Space will 
select one.  The Tab key should be used to step around the other controls on the screen.

Both of these options are described fully in the "Creating worksheets" manual.
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Saving and documents
Note: this section initially describes the default behaviour.  It can be simplified for users - 
see pError: Reference source not found.

Splash documents can be saved to disk much like with any other software, using the 
options on the File menu:

• Save (Control + S) saves the current document, overwriting the copy it was loaded 
from, if applicable.  If it is a new document, Splash will ask where to save it.

• Save as > Splash! (Control + Shift + S) also saves to disk, but always asks where 
to save, instead of replacing the previous copy.

• New (Control + N) creates a new, blank document of the current type.

• Open (Control + O) opens a document previously saved on disc.  To open a 
worksheet from the user's menu,  use the first option to return to the menu 
instead.

In user mode, for simplicity, Splash usually only keeps one document open at a time.  If 
you create a new document, or load one from disc, it will replace the current one.  If the 
current document is not already saved, Splash will prompt to save it first.

Teacher mode allows multiple documents to be opened, which are represented by tabs at 
the top of the screen:

You can switch on multiple documents for user mode (or off for Teacher mode) using 
Settings >  Show/Hide... > Other >  "Display tabs allowing multiple documents to be open
at once".  Note that the multiple document selection is not keyboard accessible.

Saving into the menu

Hint: you can also preselect a single folder in the user's menu which all files should be 
saved into  - see the Setting up Splash users" manual for details.

As an alternative to saving to a folder on disc, you can save a file directly into the current 
user's menu, using the menu option: File > Save into user's menu.  This opens a screen 
listing all the folders in the menu:
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Select one of the folders, and enter a name for the file at the bottom, and click OK to save
it.  The advantage of doing this is that the user can later access the file easily from the 
menu.  This saving screen is also easier to navigate than the standard Windows file saving
screen.

Technical note: files saved like this are stored on the hard drive, within Splash's internal 
data folder (usually c:\programdata\splash 3)

Exporting the document

There are other options on the File menu to export the Splash document in other formats. 
These only export the graphics, and cannot be with be loaded into Splash.  They can be 
useful, however, in order to export a copy of a student's work that can be viewed by other
software, without requiring Splash.

These page export options are only available in Teacher mode, or for advanced users.

• Save as > Save as Splash! V2 file saves in a format compatible with older versions 
of Splash!.  Only use this if the file needs to be opened by someone else who does 
not have the current version.  

• Save as > Export as PDF saves a PDF file containing the current document.  This is
the best option if you need to store a record of a student's work readable by 
someone who does not have Splash.  PDF files are effectively not editable – if you 
load the PDF back into Splash it will not be the same as the original document.

• The Export page submenu has options to export just the current page in various 
graphics formats (or as a separate Splash file). 

Simplifying the saving process

For younger users, or users who struggle with Windows files due to the accessibility 
issues, it is possible to simplify the way that documents are saved.  This is done from the 
Settings > Saving page.

See the "Getting started with a new user" manual for details.
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Tools for teaching Arithmetic
Splash contains several tools which can be used when teaching arithmetic.  All of these 
are interactive and do not simply draw a shape on the page.  These tools can be used 
both directly by the user, or can be used by an assistant in Teacher mode to set up 
exercises.

Each of these tools include numerous features and can be configured for different 
exercises.  Each is described fully on the following pages.

Number Line A line with numbered points, as used in the early 
teaching of arithmetic.

Blank Number Line Users can use this tool to replicate exercises done on 
pen and paper where the student draws out arithmetic 
tasks using a blank line and arcs joining numbers.

Tally A counting tool for drawing tallies.  

Number / Arithmetic This types numbers on the page, which automatically 
positioned in a grid, for laying out standard arithmetic 
sums.  It includes features for crossing out, carrying 
numbers, total lines etc

Number Square Grid Displays, by default, a 10x10 grid of numbers within 
which the user can move around and colour/highlight 
numbers.  Can be configured in teacher mode for 
different exercises.

Clock Displays a clock with movable hands.  The exact features
can be configured in teacher mode.

Number line

Adding a Number Line to the page: (this might be done by either the student or teacher)

 Select the number line tool, by pressing Shift + N.

 Move to the start position of the line and press space.

 A counting line will be created with the default length. 

 Use the right arrow key to lengthen the line.

 If it is too long use the left arrow to shorten it.

24 of 69 Splash! for Keyboard users



Splash! City - Access to Shape, Drawing and Number

 To create the line press space again.

Using the Number Line (select it first using F9)
• Press Space to count.

• Use the + or - keys to restart counting at the current position.  + will count up, and
- will count down.  For "+" there is no need to press Shift if using the key on the 
main keyboard (so you are technically pressing "=")

• Press Escape to reset it.

If you try to count beyond the end of the line the numbers will scroll as you count (this 
scrolling can be disabled - see creating number lines, below).

The keys Alt + Left arrow and Alt + Right arrow can also be used to move the start point 
to the left or right.  If a teaching assistant is using a mouse they can also click anywhere 
on the line to set a new start position.

Configuration of the Number Line
The display and functionality of the Number Line can be changed by double-clicking it in 
teacher mode.

Basic settings:

 First number to display: the number at the left hand end. 

 Display in steps of: the difference between consecutive numbers on the line.

 Number of steps to move: sets the number of jumps made at each count.  This is 
the number of steps, so if the steps are displaying in 10s and this is 2, then each 
click will count on 20.

 Initial value is: sets where on the line the initial marker is set and where the marker
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will re-set to. 

 Start counting downwards does just that when the page is first displayed.

 No scrolling: if this is ticked then the line will not scroll, and the user cannot count 
above or below the numbers displayed.

 Don't allow the user to count downwards below the starting point: If this is ticked 
the user can count up and down, but will not be able to count down below the 
initial number.  If scrolling is enabled, ticking this ensures the user cannot count 
down below 0 (assuming 0 is the first value)

 Number of steps to show: this adjusts the number of ticks and therefore the space 
between them.  Usually they are 1cm apart, and making the line longer displays 
more numbers.  If you set a fixed number of steps, then stretching the line moves 
the ticks and numbers closer together or further apart.

Advanced options:

 Only show every second number: an alternative to Label only numbers which can 
be used more easily to display only alternate numbers.  This can be helpful if 
counting in large numbers, or if the user requires very large text, and there isn't 
space to display every number.

 Show marker on start value: by default this is ticked.  Clearing this will remove the 
blue indicator showing the initial value.

 Speech counts how far user has counted from start point, not current number: If 
speech output is switched on for the user (in Settings > Accessibility > Speech) 
then the Number Line will speak each number. Ticking this box makes it speaks the
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number of steps, rather than the current value.  If the user started from 0 there is 
no difference, but for any other starting value this has an effect.

 Use decimal numbers: If this is ticked, then the first 2 values on the Basic Settings 
tab can use decimal points to set up a number line which is not counting in whole 
numbers.  Ticking this makes no difference to the line itself unless you enter 
decimals on the first tab.

For some exercises it is helpful to highlight certain numbers or only label some of the 
numbers (e.g. 0,10,20). You can do this by entering a list of numbers, separated by 
commas, into one or both of the boxes. 

 Highlight numbers: enter a list of numbers separated by commas, these numbers 
will be highlighted on the number line. This box must be blank or contain a comma-
separated list of numbers.

 Label only numbers:  Normally all numbers (or every other number – tick box) are 
labelled.  Numbers listed here separated by commas will be the only ones shown 
on the number line. This box must be blank or contain a comma-separated list of 
number.

Example

This Number Line has a fixed number (30) steps displayed, causing the individual ticks to 
be much closer together than normal.  And then on the advanced page it was specified 
that only 0,10,20 and 30 should be labelled:

Feedback sound
You can switch on a feedback sound - a clicking noise made each time the user steps 
along the line - by ticking this option in the settings: Settings > Work area settings > 
Shape/Number settings > "Use feedback sound when stepping along Number Line"

Blank Number Line

The Blank Number line (sometimes called the "Empty Number Line") can be used to work 
out a range of maths problems including addition, subtraction, multiplication, division, 
questions about time etc.  The pupil works out an answer by creating “jumps” or arcs 
along a line and writing down the value of each jump and the number that is 
added/subtracted. It is also used to work out word problems such as: A piece of string is 
42cm long. You cut off 25cm. How much is left?
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42 is placed at the end of the blank number line, 20 is subtracted to get to 22 and 5 is 
subtracted to arrive at the correct answer 17cm.

To start your number line
Select the blank number line tool (Alt+N)

Move to where you would like the number line to start and press Space. Move across the 
page and press 'Space' again when you want the line to finish:

With the line selected, press Space to start a new arc.  The first arc will start at the left 
end of the line. 

Once the arc has been started, move the pointer along the line to extend the arc and 
press Space again when you want to fix the arc.  To abandon an arc, press Escape.

To start putting in the numbers, press the Enter key.  (Pressing the Enter key repeatedly 
moves between the possible positions to enter numbers).  You can write numbers and/or 
words into these boxes. 

To produce the example below, after pressing Enter, type "137" into the first box that 
appears. Press the green arrow again to place a box above the arc. Type "+3". Press 
Enter again to place a box at the end of the arc. Type "140". 
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To begin a new arc press Enter until the arc itself is selected, and you are not typing into 
any of the boxes.  Then press Space again to start a new arc.  The arc will start at the 
pointer position – note that if the pointer is beyond the left or right of the line, this will be 
ignored.  Alternatively press Control + Space to start an arc which adjoins the previous 
arc, ignoring the pointer position.

Extend the arc and press Enter to place another box above the number line to write the 
number "+60". The final box will be for the number 200. The sum of the jumps (60+3) 
will give the answer.

Using the Blank Number Line with arcs from left to right.
If you wish the first arc to go backwards, starting on the right, press the '-' key before 
starting the first arc.  

When you press Space the first arc will start from the right hand side of the blank number 
line. Extend the arc by moving the pointer along the line and left-clicking when you want 
to fix the arc. Add boxes and write in numbers as above using the green arrow.

Until the first arc is completed, a red arrow is displayed to indicate the line is working 
right-to-left.

Editing an existing line

To make changes to an existing line with arcs

• Use Tab/Shift + tab to select individual arcs, or the base line (but once typing tab 
will instead move around the typing positions, like 'Enter')

• When an arc is selected, use the '+' and '-' keys to adjust the length of it.  (For '+' 
you can press Shift + '=' or just the '=' key)

• Pressing Delete removes the arc

• When an arc is selected, pressing Enter moves around the positions in which you 
can type.  Use the keyboard and backspace as normal to change the numbers or 
text in these positions.
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Tally

This tool allows the user to count with tallies, even if the user doesn't have sufficient 
coordination to place the lines correctly, whether on paper or on the computer.

To create a tally:

• Select the Tally tool on the left

• Move anywhere on the page and press 'Space# to start a new tally with one 
vertical line

• Count onwards using the \ key to add a vertical, or / key to add a diagonal.

• Press backspace to delete the last line.  This can be used repeatedly to erase each 
line all the way back to the start, if desired. 

Note that Splash does not enforce the correct count of 4 verticals followed by a diagonal 
line.  The intention is that the user must still understand the method and choose the 
correct line, while Splash deals with the line positioning that the user may not be 
physically able to do.

Pressing | adds another vertical on the end, no matter what came before.  Pressing / adds
a diagonal line through the last verticals, no matter how many there were.  If there was 
no vertical, it just adds a separate diagonal line, so it is possible to create a very wrong 
tally:

Numbers tool

The number tool allows the user to place numbers in regular rows and columns, in order 
to write out arithmetic exercises.  The numbers are placed in squares defined by the 
square paper setting. The tool also supports carrying, decomposition, crossing out etc.

To activate this tool press 1.

The arrow keys are used to move around the square array.  Use the number keys to enter
values.  You can enter up to 3 digits in a square.  Backspace deletes digits in reverse 
order.  Pressing Shift + arrow key will move to the next empty space in the appropriate 
direction.  (Tab can also be used to go to the first empty cell to the right).

Pressing Shift + Enter will perform a carriage return: it will move to the next line, and also
move left so that the typing position is under the first digit of the previous line.

Auto-move: you can switch on auto-move so that the typing position immediately move to
the next cell after typing any digit by pressing Shift + Control + Left/Right arrow 
(left/right arrows giving different directions of movement).  The first 3 buttons on the 
numbers palette, below, can also be used to control this.  To switch off auto-move use 
Shift + Control + Up arrow.
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The numbers palette can be used by both pointer and
keyboard users to enter other symbols, and do some
formatting.  The first line of buttons, and most of the
second just type the symbols.  

All of the functions on here can also be accessed via
the keyboard.  Simple symbols are typed using the
keyboard as normal.  "+" can also be typed by pressing
the = key twice.

The division symbol, "÷" is typed using the / key.  (Note: if there is already a number in 
the cell then "/" does decomposition instead)

Lines around the cell are added or removed by pressing the \ key (lines above and below) 
or "|" (ie Shift + \) repeatedly.  The latter adds or removes vertical lines.  This 
functionality is also available using the four buttons bottom right on the palette, and the 
first button on the second line.

In order to create lines both above and below quickly, for the total at the
bottom of a sum, use the # key.  This adds lines above and below.  If the
auto-move is switched on, pressing this will also move to the next cell.

Letters and many other symbols, such as “?” or “%” can be typed as
usual with their normal keys.  All currency keys (£ $ and €) will type the
local currency symbol based on the machine settings.

Decimal points
By default the decimal point will appear between two cells unlike all other
symbols.  Pressing the "." key in an empty cell places the point to the left.  If
a number has already been typed in the cell, then the decimal point goes to
the right, and the typing position automatically moves right.  The behaviour of the decimal
can be changed in the settings so that it occupies its own cell, see below.

Pressing "," will also type a decimal point to support European languages where the 
comma is the decimal separator.  

Other Number tool functions
";" key = Carry: press this to enter another number, smaller, under the current cell
indicating a carried value.  Press the button again, or the up arrow, to return to the
main number.  Initially a “?” will appear in the carry position until a number is
entered.

"/" key = Decomposition: pressing this will cross out the original number and allow a new 
number to be typed in the same cell.  Note: the behaviour of this key changes
when a number is entered.  If this key is pressed in an empty cell it types the
division symbol.  If pressed after a number is entered it performs decomposition.
To remove the decomposition press backspace to delete the second number.

Space key = Prefix 1: Pressing this inserts a smaller "1" to the left of the main
number.  Press the key again to remove it.  This only applies once a number has
been entered in a cell.  Pressing "Space" in an empty cell does nothing.
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"[" key= prefix digit: Pressing this adds another, smaller number to the left of the
main number.  Initially a “?”  appears until a number is typed.  Press backspace to
remove a prefix number.  If no number has been typed, pressing this key again will
remove the “?” placeholder.  This option can only be used if 1 digit has been typed.
If 2 or 3 digits have already been entered in the cell, then this key is ignored.

Control + / key: Enter a fraction in a single cell using the equations
tool.  Once pressed a divisor line appears and you are typing the top
half of the fraction.  Use the down arrow to move to the bottom half.
And the right (or left) arrows to step out of the fraction and return to
the number tool.

Control + "#" key: This will start entering any item or symbol from the equations tool.  It 
brings up the keyboard-based symbol selector:

Type either the code for the symbol, if known, or usually just part of the description to 
search for the item that you want.  Once you have started in the equation tool further 
typing will use the equation tool, until you use the left or right arrows to navigate the 
typing position off the end – at which point it will revert to the numbers tool.  You can tell 
which is being used as the numbers tool always highlights a cell on the page, whereas the
equations tool just has a regular typing cursor.

Number tool settings
There are three settings which affect the Number tool.  These can be found in Settings > 
Work area settings > Shape/Number settings.

Hint: as with all settings, changing these would usually change the user settings, affecting
all of that user's work, but you can select to adjust these only for the current document.

The first option, if ticked, prevents more than one digit being typed in any cell.  By default
up to 3 digits can be typed.
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The second changes how a decimal point is displayed.  By default this is
ticked and a decimal point appears between 2 cells.  If this option is
switched off then a decimal point occupies an entire cell as shown here.
Note that this also changes slightly how it must be typed.  When the decimal appears 
between 2 cells the user does not need to navigate, they can just press "4", ".", "5" in 
sequence.  If the decimal occupies a cell, then it behaves like any other symbol and 
pressing it will overwrite any number already in the current cell.  So the user must now 
press "4", "right arrow", ".",  "right arrow", "5" to type this number. (unless auto-move is 
switched on)

The third option controls the pointer movement.  If this option is on, then the Windows 
pointer is moved automatically to track the typing position.

Number Square Grid

The Number square is a powerful tool in maths teaching.  The
default square displays numbers from 1 to 100 in rows of 10. 

Move the pointer over a cell in the square with the arrow keys
and press Space to select it.  The number square is navigated
with the arrow keys.  Cells can be highlighted and have the
highlight removed with the Space key

Making a Number Square 
Choose the Number square tool.

Move to where you want the top left corner and Space will place the square. 

Editing the Number Square
Configuration of the Number Square is usually done by an assistant.  Select the square 
and press Control + Enter to open the number square editor.
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The first tab of the settings controls what grid is displayed and how it is used.  The 
number of rows and columns can be set to a maximum of 25 each.  The "Display in" 
option can be used to display tens or hundreds instead of unit numbers.

The multiplication grid option changes the numbers
displayed: showing a times table grid rather than a
count.

The next options control how the user interacts with the
grid.  By default they can colour/uncolour cells and also
type their own number and delete existing numbers.  For
many activities only one of these is required: the user
might colour multiples within a grid, but not need to
change any numbers.  Or for a different exercise the
user might be filling in missing numbers, but no
colouring is needed.

The last line at the bottom of this tab is a shortcut that
changes several of the options:

This tool is sometimes used to make activities that don't use numbers at all: for example 
making reflections of patterns.  Clicking this link removes all numbers, giving a plain white 
grid.  It also switches to multi-colour mode (see below).

The second tab changes the colouration of the grid:

The first choice is whether there is a single highlight colour (the default), or whether the 
user should be allowed to colour each cell differently using the Fill Palette.  The latter 
option is more usually used for shape/pattern activities, with no numbers, rather than 
mathematical exercises.  When switched on Space applies the colour currently selected in 
the Fill Palette.  Selecting a new colour in the Fill Palette does not change the currently 
selected cell in the grid.

The next options select the colours used the grid.

The final option changes the display of “unused” cells - see below.  By default these are 
invisible, but can instead be blacked out like the unused boxes in a crossword.
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The last tab allows each cell to be modified.  This can be used to create partial grids, or 
change which cells are coloured when the exercise is started.

Each cell in the square can be:

 Unused (1 and 6 in the example)

 Number missing (5 and 9)

 Coloured (3,4 and 8)

 Coloured and number missing (14)

The user cannot navigate to “unused” cells, colour them or enter numbers.

To make changes, first click on the option on the right
that you want to apply.  Then click on a cell in the grid
to change it to that state.  Or click-and-drag to change
an entire rectangle.  In this way a large number of cells
can be changed quickly.

The 0 square
It is possible to add a '0' square at the top left of the
grid:

This is mainly used by switch users.  Having the highlight start at 0 rather than number 
one is often easier for them.

This is switched on in the settings: Settings > Work area settings > Shapes/Number 
settings > “Display '0' cell in number square grid”.  There is also a link to this in the first 
tab of the number grid editing screen.  Because this is in the settings, it will affect all 
grids, not just the current one. 

Clock

This places a clock, with movable hands on the page.  The appearance and behaviour of 
the clock can be adjusted for different exercises. To place the clock:

• Select the Clock tool (Alt + C)

• Move to the top left corner of an imaginary square containing the clock, and press 
Space.

• Move to the bottom right corner and press Space again to finish..

To change the time:
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• Press Enter to select a hand or +change which hand is selected

• Press + or – to adjust the selected hand.

Usually the hour hand will move slightly as the minute hand moves, but this can be 
changed.

To change the behaviour of the clock either double-click it or select it and press 
control+Enter in Teacher mode.  This opens the editing screen:

The first three lines choose the different ways in which the hands can operate.  The first, 
default option makes them interact correctly: if the minute hand is at "6" then the hour 
hand will sit halfway between 2 hours.  The second option causes the hour hand only to 
point directly at hours: this can be used for simplicity with some younger users doing early
exercises with clocks.  The last option allows the hand to be moved completely 
independently.  Use this if you want the student to place the hour hand correctly without 
any help.

The next option lets you restrict the movement of the minute hand.  You might select the 
"15" option with younger users who are only working with quarter and half hours so far.

All the remaining options change the display of the clock.  If the second hand is displayed 
it always works independently of the other hands.  Moving the second hand will not move 
the minute hand.

The "Show numbers" option chooses between one of these displays:
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Equation

Note: below is a brief introduction to the equation editor.  There is a separate manual for 
the Equation editor.  Select 'Equation editor' from the menu: Help > Manuals.

The equation editor is a WYSIWYG editor which allows equations - simple or very complex
- to be typed:

Getting started
To write an equation:

• Select the Equation tool

• Click on the page where you want to start typing and press Space.

• Type…

• The arrow keys will now act to move the typing position within the equation.  Press 
escape to stop typing and have the arrow keys again move the Windows pointer.

To edit an existing equation, use the Equation tool and press Space when the pointer is 
over the equation.  Alternatively, if an equation is selected using the F9 Selector tool, 
pressing control + Enter will start typing into it again.
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Typing symbols
Standard characters should be typed using the keyboard.  Special symbols can be entered 
in one of  two ways.  There are special palettes on the right hand side giving access to 
most symbols (the exact palettes which appear depend on which option was selected in 
the user menu).  However these are more useful for pointer users.  For keyboard users, all
the symbols can be accessed by pressing the "#" key to show the symbols menu.  Each 
symbol has a short code.  You can either type the code, or just part of the description to 
search for it.  Then press Enter to select.

For example the square root symbol has the code "sqr".  You can add a square root to the
page by typing "#sqr" and then pressing Enter.  The code appears in blue as it is typed: 

Beneath the code you are typing appears the meaning.  If an incomplete or incorrect code
is typed, beneath this lists all possible matches:

Initially this lists all codes starting with the letters that have been typed so far.  Use the up
and down arrows to scroll through the list, and press Enter to select one of the options.  
The list may be long if only 1 letter is pressed and will scroll if necessary:

Searching by name: If you don't know the code for the symbol you want, just type part of 
the name.  When you type something that doesn't match any of the short codes, then 
Splash will search the names of the symbols instead and list all matches:
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Again use the up and down arrows to move through the list, and Enter to select.

Moving around the equation
Move the typing position using the arrow keys, or by clicking where you want to type.  
Note that all four arrow keys may be needed: the up and down arrows are needed where 
some part of the equation is laid out vertically.

Structural elements
While many of the symbols are just that - symbols - some items within an equation 
provide structure and can contain any amount of other symbols.  For example brackets, 
divisors, square roots, integrals.  Splash will automatically size and lay these out.

In general press the button for the structure first before typing anything that goes
within it.  The typing position will then move within.  For example to create a
divisor press the button first.  This will show a short horizontal line with the typing
position on the top of the divisor:

Type the top half of the divisor.  The line will stretch to fit automatically:

Press the down arrow key to move down to the bottom half of the divisor, and again start 
typing:

The same works for any part of an equation containing more content, they will 
automatically expand as more content is added:
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 >  > 

 >  > 

If you have typed the content first at want to add brackets/a divisor/root around it, then 
you can do this.  For example, in the root example above, if you typed the x2 + y2 first:

then select the entire text by moving the cursor to one end and then using shift+arrow 
keys to select the text:

Then type the code (#div) for a divisor:

While you are typing the #div code it may overlay the selected text, and look messy.  
Don't worry about this;  once the code is selected, it will placed around the text correctly:

The just press the down arrow to move to the bottom half of the divisor.  The same can 
be done to add the root: select the entire divisor and then type the #sqr for the square 
root.

Starting new equations
There are 2 buttons on the palettes which help with starting another equation directly 
beneath the one you are currently typing:

 will start a new empty equation.  On the keyboard you can press Enter to do this.
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will duplicate the current equation on the next line and start typing in it.  Press Shift +

Enter to do this from the keyboard.

Alternatively, you can start a new equation elsewhere on page by just using the Equation 
tool again

Special keys

There are some key combinations that can be used to type common symbols:

Alt + P = π (lower case pi)

Alt + / = ÷ (division symbol)

Alt + 0 = ° (degree symbol)

Alt + 8 = · (multiplication dot)

Alt + X = Curly x

Alt + Y = Curly y

The key combination for the degree symbol can be used throughout Splash!  The other 
keys only apply within the equation editor.
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Working with other tools
Shapes and tools can be selected by single keys or key combinations.  For example 'S' will 
choose Square, R the rectangle and Shift + R opens the ruler etc. The default set of key 
assignment can be found in Appendix 1

Simple shapes: Lines and polygons

Splash! has a number of different line and simple geometric tools. All lines can have their 
style changed with the Line Colour', 'Arrowheads' and 'Line Style' Palettes.

All of the simple shapes are drawn in the same way:

• Choose the appropriate tool

• Move to the start of the line / at the start of one edge for a polygon.

• Press Space to fix that point

• Move to the end of the line / other end of that edge for a polygon

• Press Space to fix that point

• For shapes with an unlimited number of elements, repeat this to place additional 
points, and press Enter instead of Space to place the last point and complete the 
shape.

• For shapes with a fixed number of elements, press Space place each point - placing
the last point completes the shape.

Shapes that can be drawn this way:

Line

90/45 degree 
line

As line, but it will always be drawn horizontally, vertically or at
45 degrees.

Arrow As line, but it will be drawn with an arrow head on one end.  
(Arrow-heads on lines can be controlled in detail using the 
Arrow-heads palette - which is usually only visible in Teacher 
mode)

Joined line Any number of straight lines joined together.  Use Enter to 
place the last vertex and complete the shape.

Irregular PolygonThis is like the joined line, but always forms a closed shape.  
Click to place each point, and use Enter to place the last 
point, completing the shape.

Curved line This works exactly like the joined line and is created by 
placing a series of points;  but rather than a jagged line a 
smooth curve is produced.  (See also freehand curve)
Note: if the end point is placed almost on top of the start 
point, this automatically converts to a closed curve.

Closed curve This is almost the same as the curved line, except that the 
shape is always closed - joining back to the start point.

Square The first two points place any edge.  Moving the pointer then 
chooses between the square being left or right of this line, 
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and clicking a third time completes it.
Rectangle Placing 3 points completes this shape.

Orthogonal 
Rectangle

This also drags a rectangle, but it is always drawn aligned 
horizontally and vertically.  Unlike most shapes the first 2 
points do not form one edge, but should be opposite 
corners.
(Note: by default this shape is not enabled in most activities.  
It is used instead of the rectangle in Maths/Arithmetic 
activities)

Parallelogram Like the rectangle, placing 3 corners completes this shape.

Equilateral 
triangle

Triangle with 3 equal sides

Isosceles triangle Triangle with 2 equal sides.  The first 2 points form the other, 
non-equal side.

Scalene triangle Triangle with 3 different sides

Regular polygon A regular polygon with any number of sides from 3-20
See below

Connector line A line connecting 2 other shapes
See below

Free-hand line A line drawn by moving the cursor free-hand - this shape is 
not very effective using only keyboard control who are better 
using the Curved Line tool listed above.

Just a few of these have special behaviours:

Regular polygon

Like most simple shapes, the first 2 points determine one side.  Move to either side and 
press Space again to determine whether the shape is on the left or right of this line.  You 
can also change how many sides the polygon has at any time by pressing the + and - 
keys)

Connector Line

This is used in technical diagrams to show a connection between 2 other shapes on the 
page.  It displays a line between the shapes - and the line may (automatically) form 
multiple segments in order to connect without crossing over either of the shapes.  If one 
of the shapes the line is connected to is moved, then the connecting line will 
automatically move with the shape.  One or both ends of the connector can be left 
dangling - not connected to any shape.

The line is drawn just like a simple line: just place the 2 end points.  Any zigzags needed 
to join the 2 ends will be created automatically.
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Note: the 'Snap to' setting (see p10) is ignored when adding a connector - it automatically
connects to certain points on a target shape.  When adding or moving a connector, the 
possible locations it can connect to will be indicated with purple circles.

Circles

Each of the circles requires marking 2 or 3 points - exactly where depends on the shape:

Circle Move to the centre of the circle and press space
Move to any point on the edge of the circle and press Space 
again (ie the second click sets the radius of the circle)

Ellipse To draw an ellipse you first place the long axis of the ellipse. 
ie:

• Move to one narrow end of the ellipse and press 
Space

• Move to the opposite narrow end of the ellipse and 
press Space

• Then move to indicate how wide the ellipse is and 
press Space again to finish.

Semi-circle To draw a semi circle, first place the baseline, by indicating 
each end.  Then move to one side and press Space again to 
specify which side of the baseline the semi-circle appears.

Geometry tools

Ruler Measures distances.  Note: by default this does not remain 
permanently on the page, and is only used for measurement.

Protractor Measures angles.  Note: by default this does not remain 
permanently on the page, and is only used for measurement.

Compass/Arc Performs the functions of a compass when doing geometry 
with pen and paper.  See below.

Infinite line This draws a line, and is used just like the normal line tool 
(see p42).  However the line is always drawn extending all 
the way to the edge of the page.  This can be used in some 
geometry exercises where a line needs to be drawn through 
2 points, but extending onwards.

Angle label This tool is a convenient way of adding a label indicating an 
angle.  It is more often used when making worksheets, and 
less often by students themselves.  The size of the angle is 
automatically displayed – unless the software is in exam 
mode, in which case the number is omitted.
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Compass or Arc tool 

This replicates the function of a compass tool when writing with pencil and paper.  It 
draws arcs - and can be used to draw several arcs with the same radius.  It does not 
produce a closed curve and cannot be filled.

Unlike most other shapes, when drawing several arcs, they do not start completely afresh.
The first arc can affect the subsequent ones.  This matches the way a physical compass is 
used: it can be used to draw several arcs with the same centre, and/or several arcs with 
the same radius.

To draw the first arc:

• Move to the centre of the circle of which this arc is part and press Space

• Move to one end of the arc and press Space

• Move to the other end of the arc and press Space (or Enter - see below)

This completes the arc, and immediately starts drawing another arc with the same
centre.  If you don't want another arc, either press the escape key afterwards to cancel 
the new arc;  OR press Enter instead of Space when completing the previous arc.  If you 
press Enter it indicates you have finished, and don't want to draw more arcs from the 
same circle.

Once you have finished drawing arcs around the same centre, the radius of the arc 
remains fixed.  This is like a physical compass: it is often lifted off the page and moved 
to draw another arc of the same size.  The next arc drawn will automatically have the 
same size as the previous.  The arc button on the tools palette which gains a lock symbol 
when the radius is fixed:

 Drawing the first arc: the radius is not yet set.

 Radius is now fixed for subsequent arcs.

Subsequent arcs with the same radius are drawn just like the first: to the centre of the 
circle, press Space, then moved to each end of the arc.  However wherever you press for 
the first end of the arc the radius will be adjusted to match the first arc - you are only 
setting the angle.

Note: if the option at Settings > Work area settings > Editing in Work Area > 
"Automatically change to the selector tool after placing any shape on the page” is 
switched on, then the radius will not be remembered.  Changing tools in the palette 
resets the radius so that it must be selected for the next arc.

To draw a new arc with a different radius, just select the arc tool in the palette again, by 
pressing V - the lock symbol will be removed and the next arc will be drawn afresh with 
adjustable radius.

At any time the radius of the current arc can be changed by pressing the + / - buttons on 
the keyboard.  This can be used to draw arcs of different radii around the same centre 
point. 
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If you want to use the compass the measure a distance without drawing, so you can draw
an arc elsewhere on the page with that same radius, then click at both ends of the line 
you want to measure, as if drawing an arc.  Then press the key to select the Arc tool 
again.  This fixes the radius of the compass, until it is unlocked as above.  It also clears 
the current shape so that nothing is drawn at the current location.

Ruler

Note: there is usually only one ruler on the page.  Starting a new measurement with the 
ruler tool automatically removes the current ruler, and they are not saved if the document
is saved.

 To open the ruler press Shift + R

 Move to the place you want to measure from and press Space 

 The zero point on the ruler will be fixed and when you move the cursor the ruler 
will be drawn out.  Default length is 10cm or 6", but it will extend automatically if 
the pointer is moved further from the start.

 A red line shows the current point of measurement and, depending on the options 
chosen, this measurement will be shown as a digital read-out at the bottom left of 
the drawing area. 

 Move to the point that you want to measure to and press Space again

To make a new measurement just press Space again to place a new ruler – the first will 
automatically be removed.

Keeping the ruler on the page
If you want to keep the ruler as part of the document permanently, so that it is not 
automatically removed, once it has been placed, press Control + Enter.  This turns it into 
a regular shape which can be selected, moved and deleted as normal.

Settings
By default the ruler works in millimetres.  The measurement units used by the software 
can be changed in the settings (either the user settings, or it can be changed to a single 
document in the document settings).  Go to Settings > Work area settings > Display 
settings > "Display measurements in:" to change this.  Is the units are changed to cm, the
display of the ruler does not change, but the measurement in the information line at the 
bottom of the screen will be in centimetres.  If you select inches, the ruler will be 
displayed in inches.

Usually the ruler displays a tick every 1 mm.  If the display is zoomed out this may be 
reduced automatically to make it more readable.  You can also change the number of text 
labels to use in the settings under: Settings > Work Area Settings > Shape/Number 
settings > "Ruler displays ticks (at most) every:".  This may make the ruler easier to read 
for VI users.

You can also increase the size of the numbers on the ruler by ticking this option: Settings 
> Work Area Settings > Display settings > "Use large text on ruler and protractor". (This 
option is also included on the VI page)
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Protractor

Note: there is only ever one protractor on the page.  Starting a new measurement with 
the protractor tool automatically removes any protractor currently displayed on the page 
and it is not saved with the document.

The protractor allows you to measure angles or to be used to construct shapes at 
measured angles. 

 Move to the point where you want the centre of the protractor to be and press 
Space

 A faint line will be drawn in the workspace.

 Move so that this is along the line you want to start measuring from – this will form
the flat base of the protractor (in 180 degree view) – and press Space again.

 Move so that the red line which appears is coincident with the angle you wish to 
measure or the angle is the value you want; press Space

 The red line shows the current measurement and, depending on the options 
chosen, this measurement will be shown as a digital read-out at the bottom left of 
the drawing area. 

Keeping the protractor
As with the ruler, if you want to keep the protractor on the page permanently, after 
placing it press Control + Enter.

Ruler and protractor hints:

• If using the Ruler or Protractor to measure other shapes, it is helpful to switch on 
Snap to Shape (see p10)

• By default, the measurement is displayed in the information line at the bottom of 
the screen.  If the user is doing an exercise where they must read the value 
themselves and this should not be displayed, it can be hidden by going to Settings 
> Screen Contents and layout > Screen contents > "Display info/measurements 
line".  To do this for one exercise only, change the "Apply Changes to:" option at 
the top to "This document" before making changes.

 Angle label

Hint: this works best if snap-to-shape mode is selected.

To place the label:

• Move to the apex of the angle to be labelled and Space

• Move to one of the ends of the arc which will be drawn and Space

• Move to the other end of the arc and press Space to finish

The text displaying the size of the angle appears automatically once it is completed.  If the
angle is exactly 90° it will be displayed as a right angle instead, as is usual in geometry:
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The way in which this is drawn is very similar to the Arc/Compass tool.  However, it is 
simpler to use – it only draws a single arc, and never locks the radius.  And it 
automatically adds the text.

The text is omitted whenever Splash is in exam mode.

Transformations

There are 5 transformations that can be applied to any shape or group of shapes. These 
tools do not draw new shapes on the page, rather transform existing shapes.  They can 
either move the existing shape, or make copies.

Note: the transformation tools can be used to either remove the
original shape, or make copies.  The current mode is selected using
these buttons.

For a keyboard user, the key combination Shift + Ctrl + = will toggle between the 2 
modes. If the left-hand option is highlighted then the transformations will move shapes.  
If the right and option is highlighted then the transformation tools will make copies.  
When copying, multiple copies can be created.  The user should use Space when placing 
each copy if they want to create more, and Enter to place the only or final copy.

The transformation tools can be used in geometry, but some can also be useful for basic 
manipulation of the shapes for users with imprecise control.

Move (translation) Moves the shape: first select the shape, then move 
and click to place it in its new position.

Move Horizontally / 
Vertically

As Move, but will only move either horizontally or 
vertically.  If the user tries to move at an angle the 
shape will move horizontally or vertically depending 
which is closest.

Scale Enlarges (or reduces) the shape.  First select the 
vanishing point - where imaginary lines of perspective
drawn from the old and new would meet.  Then Click 
on the shape to transform.  Move to scale the shape 
and Click again to fix it.

Rotate Rotates the shape.  First select the point about which 
to rotate.  Then Click on the shape.  Then move to 
rotate and Click again to fix the new position.
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Reflect Creates a mirror image of the shape.  Unlike the other
transformations, select the shape first.  Then move to 
any point on the line of the mirror and Click.  Finally 
moved to another point on the mirror line and Click 
again to finish.

Copy shape(s) This acts exactly like the Move tool, but always 
functions to make copies rather than move shapes.  
The usual option to select between move copy is not 
displayed.

Advanced Notes:
• The Move tool performs the same action as the Move Horizontally / Vertically tool if 

snap-to-angle (see p10) is enabled.  The specific tool is used when the complexity 
of selecting the separate snapping mode would be inappropriate, or in worksheets 
were only horizontal or vertical movement is needed.

• Usually the transformations default to movement mode.  This can be changed in 
the settings, especially when creating a worksheet where only copying is required. 
To change this go to settings >  Shapes/Number settings >  "Transformations 
default a copy, not move, mode"

• The option to choose between movement or copying mode can be hidden in the 
settings.  Go to Settings > Screen contents and layout > Screen contents > 
"Display move/copy transformation option"

Other drawing tools

Colour filler

An area bounded by overlapping shapes including lines can be filled with another shape 
with the Colour fill tool - Q .  This works like the flood fill option which is used in most 
pixel-based drawing.  It can be used very simply as a click-to-colour tool, but is also 
capable of creating complex shapes.

 Select the Colour Filler tool.

 Move to the area to be filled and Space.

 A new shape will be created bounded by the overlapping shapes. If a single shape 
is selected, which doesn't overlap with any others the shape will be changed to that
colour – as if the colour was selected on the "Fill Colour" palette.

For example, filling in the middle of the shapes on the left, fills the area around the click:
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Note: the place where you fill must be enclosed.  If there are not
lines completely enclosing the area, so that the flood fill would leak
out and fill the entire page, then nothing happens.  For example,
the rectangle on the right was drawn manually with 4 lines without
using snap-to-grid or snap-to-shape.  Trying to fill this rectangle will
be ignored, because there is a gap at the bottom right and the area
is not actually enclosed.

Working with the fill
The filled area actually creates a new dynamic shape.  If any
of the shapes around it are moved, then the fill will
automatically flow to fill the new lines.

If one of the enclosing shapes is moved from one side
of this to another, in the filled area may change
substantially like this:

The circle has been moved so that the fill is now
outside the circle

You can move to the filled area and select it using
the F9 selector tool:

There is a grab handle in the centre which allows
the fill to be moved like any other shape.  There is
also a pulsing circle (visible just below the grab
handle in this picture) which shows where the fill
was created.  It will always flow outwards from that
point. 
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Note: if it is moved manually, then it will no longer flow automatically and becomes a fixed
shape.  However you can select it and press Control + Enter it at any time to make it flow 
again (assuming it is in an area that is enclosed).

Simple mode
This tool has an alternative, much simplified, method of operation which can be enabled 
by ticking this box in the settings: Setting > Work area settings > Shape/Number settings 
> "Colour fill (paint bucket) changes the colour of single shapes as the user clicks on 
them…" (this setting is only remembered for the current document)

If this option is enabled then the filler only changes the colour of single shapes, exactly as 
selecting the shape with the F9 selector and choosing a different colour from the palette.  
This option is mainly used for making simplified colouring worksheets for younger users.

Picture Stamps

Picture Stamps are created from a library of images. 

To create a stamp image press M. 

Choose the image you want to use.
You can use the arrow keys to move
up and down the category list on the
left, and then press Tab to move to
the images on the right, and finally
Enter to select.  Use Shift+Tab to
move back to the category list.

Once the image is selected, move with the arrow keys and press Space or Enter to draw 
the image on the page.  Space will continue drawing more copies;  Enter places one and 
finishes.

While moving around a transparent image is displayed to indicate where the stamp will be 
drawn.  To change to a different image, select the Stamp tool again.

Hint: to make several images more easily accessible from the tools palette for an exercise,
in Teacher mode, draw each on the page, select it and then select from the menu Options
> Add selected shape to Palette.  The image on the page can then be deleted.

Crayon, Chalk, Paint brush and Pixel pen

Note: although these tools can be used from the keyboard, there are more useful for 
users who can operate some form of pointer control.

These 4 tools work in the same way.  Unlike most of the other tools these use pixel-based 
drawing.  They do not create independent shapes that can be selected, moved around, or 
deleted.  Rather they draw directly onto the page itself.  They are used in the KS1 Painting
activity and not generally mixed with most of the other tools.

For any of these press Space to start drawing, move the pointer around the page with the 
arrow keys and press Space again to stop drawing.  This is the same method as the Free 
Hand Line, except that the Free Hand Line creates an object which can be modified 
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afterwards.

The difference between these 4 tools is the texture
of the output.  The picture on the right shows each
(from the top: crayon, chalk, brush, pen).  With all
three tools it is possible to go over the same spot
on the page again to get a darker colour, just like
on physical paper.

Note: using any one of these tools somewhat
changes the behaviour of the Colour Filler and
Eraser tools on the page.  The Colour Filler will no
longer create independent objects and instead does
pixel-based drawing, just like these tools.  This
difference won't be obvious to most users.

The eraser also changes to pixel-based.  Therefore
the eraser tool is usually used with these tools to "rub out" mistakes.

Graph drawing tools

Many of the regular tools would be used when drawing a graph: lines, curves etc.  See in 
particular the lines and polygons on p42.  However Splash has several tools specifically to 
help with certain aspects of graph drawing.

Pie chart

• Choose tool: press Shift + O.

• Move to the centre of the pie chart and press Space.

• Move so as to draw out the radius of the pie chart and position the first dividing line
and press Space.

• Move to around the pie chart to draw the first segment and press Space.

• Move further around the chart to draw the next segment and press Space.

• To complete the final segment - press Enter instead of Space.  Or press Escape at 
any time to cancel the current segment and finish.

Once the pie chart has been draw its segments can be deleted, moved, rotated and re-
sized individually - each segment is a separate shape.  Each segment can be filled etc. 
using the palettes on the right.

HINT: Choose the rainbow fill colour before
starting to automatically fill each segment with a
new colour. 

Graph axis

Hint: it is usually best to switch on Snap to Grid first, so that the axis is aligned on the 
grid.
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This draws an entire axis, either horizontally or vertically, including tick marks and labels.  
These axes are intended to be used mainly with squared graph paper. 

• Choose the tool by pressing I.

• Move to the position where you want the left hand or bottom end of the axis to be 
(this is not the 0 point if you are using negative axes) and press Space.

• To reselect this position press Escape.

• Move to the top or right hand end and press Space to finish.

The axis will initially have one value per (large) grid square on the page, if this makes 
sense; if not it defaults to 10 divisions.  If you want the values displayed to be different 
press Control + Enter to open the settings screen.

Styling: the line colour and thickness can be changed using the standard styling palettes 
(Line Colour and Line Style).  The font size, and colour, of the labels can be changed using
the Text Style palette.

Axis settings

Values range from: sets the first and last values on the axis.  Note that the second value 
can be smaller, in which case the values count down from left to right or bottom to top.

Show values: If this is not ticked, then no numbers are displayed.  The axis can still 
display check marks however.  This might be used when text labels are to be used in a 
bar chart, for example.  Or perhaps the student needs to add the values themselves.

But hide '0' value: This only applies if the values are displayed.  This will omit the 0.  This 
can be used when horizontal and vertical axes are used, both including 0.  In this case, if 
both axes include the '0' label, then the labels tend to overlap each other.  It is best to 
omit the 0 in one axis.
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Show ticks and values every... These options control how many values are labelled. On a 
simple 0-10 axis every value would be labelled by default.  On a 0-1000 axis, however, 
this is clearly impossible.

Automatic / Manual: If the Automatic option is selected, then the software will 
choose something appropriate.  Any values entered below are ignored

Ticks: The amount the value between each tick mark on the axis.

Numbers (blank for same): the interval between each number.  This can be left 
blank, in which case the same value is used, and every tick mark has a numeric 
label.  However, if different, then only some tick marks will be have numbers beside
them.  This value must be a multiple of the value in Ticks.  For example, the first of
these has a tick every 10th number (and the Numbers option is left blank).  The 
second also has 50 in the Numbers option:

Number format: (Advanced!) This allows you specify how numbers are displayed.  It can 
be used to fix a certain number of decimal places, or include currency symbols, etc.  Use 
"0" to indicate compulsory digits, and "#" for optional.  So "0.##" would display a 
maximum of 2 digits after a decimal place.  The code "£0.00" will display in English 
currency.  The value 7 would appear as "£7.00".  The full list of codes is available on this 
webpage: https://msdn.microsoft.com/en-us/library/0c899ak8%28v=vs.110%29.aspx

"Marker" - Graph points

This tool can be used to draw scatter graphs, or mark points on a line graph.  Each shape 
is simply a single point - but can be indicated by a choice of symbols commonly used on 
graphs.

• Choose the Graph point tool by pressing Shift + M.

• Choose the size and shape of the point you want from the Point Style Palette (this 
can be selected from the keyboard with Shift + Alt + P).

• Move to the position you want to place each point and press Space.

• If the point is incorrect press press Delete (or move it, see p13).

The colour of these can be changed with the Line Colour palette and the style of the lines 
within the points can be changed with the Line Style Palette as for any other shape (see 
p59).  The actual shape and size of the marker can be changed with the "Point style" 
palette:
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Graph Origin

The graph origin (the 0,0 point) can be set for each page of a document from the menu: 
Page > Set origin.  This affects coordinates displayed in the information line at the bottom
of the screen.  For example, the origin could be placed at the origin of a graph, so that the
information is measuring coordinates within the graph.

This option does not draw anything on the page.

Choose this option from the Page menu, move to the point where you want the 0.0 point 
and press Space.

Typing text

There are 3 tools which can be used to enter text.  

For each of these backspace can be used to delete, and all 4 arrow keys can move 
through the text as normal. 

For any of the text tools the Text style palette can be
used to change the appearance of the text.  It is not
possible to change selections within the text; one style
applies to the entirety of each block of text

To edit an existing piece of text (for any of the 3 tools),
use the F9 selector tool press Space to select it, and then press Control+Enter to start 
editing the text.

Text area The simplest text tool.  Move where you want the top left of 
the text to be and press Space.  The text is always placed 
horizontally.  Pressing Enter/Return starts a new line - the 
text will not automatically wrap onto a new line without 
pressing Enter.

Text on a line This allows text to be placed at any angle, and to 
automatically wrap onto new lines if it is too long.  To start 
move to the beginning and then end of the first line of text 
and press Space at each end, then start typing.  If the text 
you type reaches the end point it will automatically flow to a 
new line.  Enter/Return can be used to manually start a new 
paragraph.

Text in/on 
another shape

See below.

Numbers Tool The Numbers tool used for arithmetic can also enter letters in
cells as well as numbers.  So for small amounts of text within 
an arithmetic exercise, or for individual letters which need to 
be laid out in grids this tool may be best.  See p30.
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Equation Editor If the text is to include mathematical equations or symbols, 
then the equation editor would be a better choice.  This 
allows normal text to be typed as part of an equation.  See 
p37.

Text within another shape

This allows text to be placed within or on an existing shape.  The exact position of the text
depends on the shape, and is not possible to add text to some shapes, such as curved 
lines.  For example:

To add text:

• Select the “text within another shape” tool

• Move the pointer over the shape and press Space.  A
prompt will appear...

• Start typing.  The text will wrap automatically at the end
of a line if appropriate for the shape.

Alternatively, for most shapes, you can select them with the F9
selector tool and press control + Enter to start typing (this doesn't work on some complex 
shapes where control + Enter opens the options screen for the shape)

The orientation of the text is done automatically:
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The buttons at the bottom of the Text Style
palette can be used to change the alignment
of the text:

Again, which options are available depends on
the shape.  On a line, for example, it is
possible to align to the left, centre or right, but
not to change the vertical positioning.

From the keyboard the key combination Shift + Alt + T will select this palette.  The keys 
Control + , (comma) and Control + . (full stop) make the text smaller or larger.

Special-purpose tools

None of these tools are used by students.

Button

This is used when designing custom palettes (like those that appear on the right-hand side
of the screen).

Container

This is used when designing custom palettes, and some worksheets.  This makes a 
container on the page: any shapes dropped inside the container will move if the container 
is moved.

Flowing container

This is similar to the container, but any shapes dropped into it automatically arranged in 
one or more lines.

Alternate selector

This tool is not used in the current version.

Sockets

This tool is used when creating worksheets.  It is used to make complex shapes fit 
together correctly.  See the separate Creating Worksheets in Splash manual.
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Editing shapes and styling

Styling shapes

The palettes, other than the main Tools Palette on the left, provide a wide range of 
formatting options for colour and style for many shapes and other objects. 

Palettes from the keyboard

Each palette has a key combination which selects it.  To make a selection from any of 
these palettes, first press the key combination, then use the arrow keys to move the 
selection around the palette, and press Enter to finalise the selection and return the focus 
to the drawing area.  The header of a palette changes to a green colour when it is 
selected, and the typing focus is in the palette.

If a palette contains buttons performing actions (such as the Choose and text size buttons
in the Text style palette) use Tab / Shift + Tab to move the focus around the buttons and 
Space to trigger a button.

Colours

For most shapes the colour of the line and the colour filling the shape can be changed 
separately.  There is a palette for each, which are almost identical:

(for text-only shapes selecting from the Line Colour palette will change the text colour.  
There is also a colour button within the Text style palette which changes text colour on all 
shapes, including those containing lines and text)

      
The main part of each palette is the 18 standard colours.  Use the arrow keys to move the
selection.  The last colour (bottom right) is transparent.

On the right-hand side are 2 or 3 extra options.  There is a key combination to trigger 
each of these.  From top to bottom these are:

• Refine colour (key = Alt + S): this displays more shades similar to the current 
colour.  By selecting the closest colour amongst the standard 18 first, and then 
clicking this is possible to choose from nearly 1000 colours in total.
Advanced: in the Settings >  Work area settings > Editing in work area, there is an 
option which changes the behaviour of this button: “Refinement button in the 
colour panel should show the standard Windows colour chooser instead”.  The 
Windows colour chooser allows access to all colours.  However using it requires 
good pointer control.

• Transparency (Alt + T): this lets you make the current colour partially transparent.  
Again, select the colour first and then click this to show the transparency options:
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• Rainbow colours (Alt + 'R'): this is only available for the fill colour, and not the line 
colour.  If this is selected then every shape is drawn in a different colour, cycling 
through the standard colours.  This can be useful, for example, with pie charts so 
that each slice automatically is a different colour to the previous one.

Note: by default these extra options on the right are not displayed for KS1 users.  They 
can be turned on or off for any user using the option: Settings > Screen contents/layout 
> Screen contents > Display advanced colour buttons

Line styles

The line styles cover line thickness and broken (dashed
or dotted) lines. The thickness and broken styles are
independent of each other. Line arrow endings are on a
separate palette. 

Arrow-heads

Note: by default this palette is only displayed in Teacher mode or for KS3+ Advanced 
profiles (see p18 for how to change this)

It is possible to display a variety of arrowheads at each end of lined shapes (this is not 
available on closed shapes such as polygons).  Arrowheads are added or changed using 
the Arrowheads palette:
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The beginning and end of the line are changed separately, and for each end 2 selections 
are made: the size of the arrowhead (on the first line of buttons) and the shape of the 
arrowhead (the second line of buttons)

Use the 'S' and 'E' keys while the palette is selected to switch between the Start and End 
selections.  Use the Tab key to switch between changing the size and style of the current 
end.

Fill effects

All closed shapes can be filled with colour, patterns, and textures in great variety.  The 
colour of the fill, and optionally transparency, is set using the Fill colour palette, above.  
There are 2 further possibilities:

Patterns
Shapes can be filled with hatching patterns.  The shapes
otherwise become transparent; the hatching lines take
the Fill colour.  The blank fill (second option) pattern
makes the shape transparent.

Textures
Shapes can alternatively be filled with a texture or
pattern.  This is done via the menu: Edit > Fill with
texture...

This displays a screen with possible textures.
Alternatively, use the button at the bottom left to
select any image from disc to use as the texture.

Text Styles

Text is adjusted using the Text style palette.  Click the
“Change font” button to choose the font, font size and
select bold and/or italic.

The next two buttons are a simpler way to adjust the font
size: the first makes the text smaller, the second larger.
Click the last button on that line to change the text colour.

From the keyboard use Tab to navigate to these buttons, and Space to activate them.
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The 6 buttons on the next line change the alignment of the text.  For text shapes only the 
first three (left, centre, right) are available and change how the text is positioned in 
relation to the starting point.  When text is added to a shape the last 3 buttons are also 
available; these change the vertical alignment of the text within a shape.

Note: There can only be one text style within any given object.  It is not possible to 
embolden (for example) one word. If you use a font that is not available on another 
computer the font will revert to Arial.

Further editing

Creating a grouped object

To create a grouped object, select all the members of the
group and press Control + G.  Once grouped, all the shapes
behave as a single shape and are moved or resized as a
single item.

To un-group select a grouped object use Shift + Control + G.
This restores the original shapes so that they can be edited
invidually.

Arranging and aligning shapes

There are several options on the Edit sub-menus which can be used to reposition shapes.  
The “Quick Transform” submenu has options to rotate or flip the currently selected 
shape(s).  These options also available on the “Quick transform” palette; but, by default, 
this is only displayed in teacher mode or for advanced users.  These options can be 
accessed from the keyboard using Alt + arrow keys:

• Alt + Down arrow = flip horizontally

• Alt + Up arrow = flip vertically

• Alt + Left arrow = Rotate left 90°

• Alt + Right arrow = Rotate right 90°

The "Align shapes" submenu has options to move shapes, such as left-aligning them with 
each other.  Most of these require several shapes to be selected and will align them with 
each other in different ways.  Each option moves shapes either horizontally or vertically, 
but never both.

The last 3 options on this submenu can be very useful.  Each of them relates to one of the
"Snap to" modes (see p10), and modifies the selected shape(s) so that it is positioned as 
if the snapping mode was selected when the shape was drawn.  There are key shortcuts 
for each of these:

• "Align with grid" (Shift + Control + F6) will try to align the shape(s) with the 
current grid.  

• "Align with other shapes" (Shift + Control + F7) will move shape(s) which are 
nearly touching other shapes so that they exactly touch at edges or corners.  

• "Align: tidy angle" (Shift + Control + F8) tries to modify shapes so that lines are as 
a multiple of 15°.  If a technical or geometric diagram has been drawn without any 
grid snapping, then most likely the lines are not quite orthogonal and look messy.  
This will tidy them to be exactly vertical, horizontal or other multiples of 15°.
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"Advanced" graphics

Usually the graphics editing in Splash is kept fairly simple.  However, Splash does support 
vector graphics editing using grab handles to adjust curves, in the way that standard 
vector graphics/Art packages work.  To use advanced graphics you must turn on 2 options
in the settings:

• Settings > Work Area Settings > Editing in work area > Right-clicking should show 
a popup menu if it has no other action

• Settings > Work Area Settings > Editing in work area > Use advanced graphics 
editing

Pop-up menu
Using the advanced graphics features requires using the pop-up menu.  This can be 
displayed by right clicking with the mouse, but keyboard users can also use the menu key 
on the keyboard instead (the key is usually at the bottom right of the keyboard between 
the control and Windows keys).

The location where the menu is displayed can be important, so use the mouse or arrow 
keys to position the pointer first.

Editing with advanced graphics
Most shapes in splash maintain their inherent nature even when modified.  For example if 
you draw an isosceles triangle it will remain an isosceles triangle after editing.  If you 
select such a triangle, there is only one grab handle to change the size, which will change 
all 3 sides:
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If you want to use complete vector graphics editing on a shape, the first step is to convert
it, so that it loses its inherent shape and now permits unrestricted editing.  This is done by
placing the pointer over the shape and selecting "Convert to advanced graphics" from the 
popup menu:

If this option is not included on the menu, then the shape already supports the full 
advanced graphics editing.

The shape itself does not change.  The only visual difference is that now different grab 
handles are displayed when it is selected:

Using these grab handles it is possible to move any vertex, or stretch the shape in one 
direction so that it is no longer an isosceles triangle.
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Adding and removing vertices
Once the shape supports advanced graphics, you can add and remove vertices.  To add a 
new the text of the shape, position the pointer over one of the lines and bring up the 
popup menu using the Menu key.  Then select Add corner here from the menu:

(The pointer was positioned where the top left corner of the menu is)

This adds a new vertex, as can be seen from the extra grab handle in the shape (left 
picture).  This grab handle can be moved like any other (right picture):

    

Similarly, a vertex can be removed by positioning the pointer over the vertex, and 
selecting Remove corner from the menu.  This will remove the vertex, leaving a line 
joining the preceding and following vertices:
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Curve editing
The main function of the advanced graphics is curve editing.  Since our example shape 
consists only of straight lines, we first need to convert one of the lines to a curve.  This is 
done by moving the pointer over the line (the top left line in this example) and selecting 
Change section to curve from the pop-up menu:

Again, this doesn't make any immediate change in the shape.  It does however, add two 
more grab handles:
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These handles allow curves to be adjusted, and work in the same way as any standard 
vector graphics software.  If, for example, both grab handles are moved to the left, the 
line that we have now converted to a curve, becomes bowed out to the left:

These curve adjusting grab handles are displayed as circles, which differentiates them 
from all other grab handles which are displayed as squares.  They are displayed on all 
curved parts of a shape once advanced graphics is enabled.  For example, an ellipse which
has been converted to advanced graphics:

Adding and removing vertices, and using the curve-editing grab handles allows complete 
adjustment of any complex shape.
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Appendix 1: Default keyboard assignments
These are the general key assignments for the work area, and almost all of these can be 
changed from the settings.  A few shapes have specific keys described above, which are 
generally not changeable, and are not listed here.  (For example 'H' and 'M' in the clock to 
select one of the hands)

Key - +Shift +Control +Shift+Control

Enter Complete Duplicate current
equation

Shape custom 
action - depends 
on shape

Escape Cancel
Space Choose

PgUp Page up
Go to previous 
page

PageDown Page down Go to next page

Home
Return keyboard 
control to drawing
area

Return to menu 
page

Left arrow Move cursor left Scroll left
Number tool auto-
move left

Alt-Left arrow Rotate right 90°

Up arrow Move cursor up Scroll up
Number tool auto-
move off

Alt-Up arrow Flip vertically

Right arrow Move cursor right Scroll right
Number tool auto-
move right

Alt-Right 
arrow Rotate left 90°

Down arrow Move cursor down Scroll down
Alt-Down 
arrow Flip horizontally

Ins Choose
Del Delete selection
0 Reflect shapes

Alt+0
Type degree 
symbol

1 Numbers
Number square 
grid Display at 100%

2 Isosceles triangle
Fit entire page on 
screen

3 Equilateral triangle
Fit width of page, 
scroll vertically

7
Move or copy 
shapes

Move or copy 
shapes 
horizontally or 
vertically
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8 Rotate shapes

Alt+8
Type · (equations 
only)

9 Scale shapes

A Arrow
Label an angle 
(tool) Select all

Alt-A
Select Fill 
Pattern palette

Select Arrowhead 
style palette

B Selection box
C Curve Closed curve Copy

Alt-C Clock
Edit settings for 
document only

D Semicircle Clear selection

Alt+D
Select Line style 
palette

E Ellipse Eraser

F
Curve drawn free 
hand

Alt-F
Select palette (Fill 
colour)

G Irregular polygon Irregular polygon Group Ungroup

I Graph axis
Add image to page
from disk

Alt-I
Import image from
library...

J Connector
K Triangle

L Line
Vertical/
Horizontal line

Horizontal text 
alignment=Left

Alt-L
Select palette 
(Line colour)

M Picture stamp Marker

Alt-M
Move current 
palette

N Regular polygon Number line New

Alt-N
Blank Number 
Line (tool)

Select palette 
(Numbers)

O Circle Pie chart Open...
P Parallelogram Protractor Print... Print preview...

Alt-P
Type pi symbol 
(equations only)

Select palette 
(Point style)

Edit grid and 
background...

Q Colour filler Equation (tool) Quit

R Rectangle Ruler
Orthogonal 
rectangle

Alt-R
Rainbow (within a
colours palette)

Resize current 
palette

S Square Shape cutter Save
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Alt-S
Choose similar 
colour (within a 
colours palette)

T Simple text Teacher mode Fill with texture...

Alt-T
Transparent 
colours (within a 
colours palette)

Select palette 
(Text style)

U Tally User mode
V Arc Paste
W Text at any angle Text in Shape
X Cross Cut

Y

Socket 
(connection point 
for grouped 
shapes)

Redo

Z
Multiple connected
lines Undo

NumPad + Increment
NumPad - Decrement

F1
Show/hide 
prompts at 
bottom of screen

F2 Small step
F3 Medium step
F4 Large step
F5 Jump to target 1 Cursor snapping off
F6 Jump to target 2 Grid snap Align with grid

F7 Jump to target 3 Shape snap
Align with other 
shapes

F8 Jump to target 4 Constrain to 15° Align: tidy angle

F9 Selection pointer Select next shape
Select previous 
shape

F11
Full-screen view 
on/off

= Increment Increment Zoom in
Comma Make text larger
Minus sign Decrement Zoom out
Full stop Make text smaller
[ Send to back
] Bring to front

Alt-P
Type ÷(equations 
only)

`
Move keyboard 
cursor to Windows
cursor position
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